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What’s New in version 3.08  January 2016 
ProVal version 3.08 introduces features for setting assumptions, dynamic asset allocation, inactive 
benefit splits, individual spot rate method for accounting, GASB 74/75 for OPEB plans, and many 
other features listed below.   

Assumptions 
♦ Power editing. You can now set assumptions for multiple items at once in the “Lump Sum & 

Optional Payment Forms” and “Increase & Crediting Rates” topics of Valuation Assumptions and 
Projection Assumptions. Assumptions you don’t change are not affected, which allows you to 
retain intended differences. For example, to change interest from 0.05 to 0.06 (but leave 
mortality as is) for the two optional forms below, select them, click Edit, change the interest 
rate to 0.06, and click OK. 

 
♦ Assumptions by both coded field and calendar year are now available for decrements, 

post-decrement probabilities, salary scale, and COLA assumptions. 

 
On a related note, COLAs can now be specified as constants that vary by coded field. 

♦ Valuation assumption sensitivities can now be run on salary inflation, COLAs, and increase 
& crediting rates in addition to interest rates and lump sum & optional payment form interest 
rates. This avoids creating additional sets of assumptions for this purpose. Sensitivities are 
turned on in Valuations and run in combination (e.g., if you check both interest rates and salary 
inflation, both are varied). To isolate the sensitivity on a particular assumption (e.g., salary 
inflation), run a valuation with only that box checked. 
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♦ Assumptions for new benefits. When editing an existing benefit and saving as new, 

valuation and projection assumptions for the existing benefit are carried over to the new benefit 
(e.g., post-decrement probabilities). This treatment applies to active benefits, inactive benefits, 
benefit formula components, accrual basis components, and payment forms. 

Forecasting 
♦ Dynamic asset allocation. In a stochastic forecast, the asset mix can now change based on 

funded status, interest rates, or calendar year. For more, see Dynamic Asset Allocation on page 
13. 

♦ When the shape of the interest rate curve changes in deterministic and stochastic forecasts, 
liabilities are now determined by discounting benefit payments rather than using duration-
based interpolation, if possible. Although interpolation generally produced excellent results, 
there were certain cases (typified by wild shape changes in the yield curve and/or lumpy 
benefit payment streams) that generated errors of 2-5% and occasionally even higher. 
Discounting benefit payments is possible whenever payments don’t depend on the interest rate 
(or there’s another benefit with matching duration where payments don’t depend on the 
interest rate). To take full advantage of this feature, be sure to run your core projections in 
version 3.08 so that they include projected benefit payments on as many bases as possible. 
This feature has been implemented for all pension modes; OPEB mode still uses interpolation 
only.  

♦ Adding multiple core projections together in a forecast is now much faster. In one test with 18 
cores, this preliminary step went from about 2½ minutes to 40 seconds. 

Pension Plans 
♦ Inactive benefit splits. Valuation results can now be split by inactive benefit. In addition, 

inactive benefits are now stored in their own library rather than saved as part of Census 
Specifications. This also streamlines setting assumptions for inactive benefits, e.g., COLA 
overrides. 

♦ Streamlined setup of “vested valued as active” participants.  

o You can check a box to indicate whether the benefit applies to actives and/or vested 
valued through actives. This eliminates the need for selection expressions that isolate 
these two groups. 



 
 

What’s New, ProVal version 3.08 - 3 - January 2016 

 
o You no longer need a dummy termination benefit for vested valued through actives to 

calculate vested liabilities. 

♦ Optional form conversions using plan factors. You can now look up plan factors for 
optional forms at commencement age, rather than decrement age. This lets you use one table 
of ERFs for all early retirement optional forms, e.g., when valuing termination benefits 
assuming multiple commencement ages. 

 
♦ Contribution policy driven by participant data. A new contribution policy in your Asset & 

Funding Policy lets you derive contributions by participant data. You might, for example, define 
a contribution formula as a specified percentage of hours for a multiemployer plan. The formula 
based on participant data is specified in the Contribution Policy Data topic of Plan Definitions. 
Results are available in aggregate in the output and by individual results in a Valuation.  

  
♦ COLA expressions for post-decrement death benefits. COLA expressions are now allowed 

for post-decrement death benefits. In addition, the new operator #MEMDTHAGE can be used 
with these benefits to vary the COLA based on the member’s death. For example, a COLA that 
stops at member’s death: 

#IF #PMTAGE < #MEMDTHAGE #THEN 
  #BEN * #COLA ; member COLA only 
#ELSE 
  0            ; 0% spouse COLA 
#ENDIF 

♦ For post-decrement death benefits, the switchover from pre- to post-commencement mortality 
has been improved. Previously, both member and spouse mortality switched at the spouse 
commencement age. Member mortality now switches at the member commencement age and 
spouse mortality switches at the spouse commencement age. 

Accounting 
♦ Individual spot rate method. For expense calculations under ASC715 and IAS19, interest 

cost and service cost can now be calculated using the individual spot rate method. This method 
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determines interest by applying individual spot rates to the benefit payments corresponding to 
the underlying present value (e.g., PBO or PBO NC). To use this method, first enter a spot rate 
interest curve in your accounting valuation assumptions and then select the “Individual spot 
rate” interest method in the Accounting Methodology topic of your Asset & Funding Policy. 

 
♦ Rollforward details. The details of the liability rollforward calculation are now included in the 

accounting Reconciliation of Funded Status exhibit if the measurement date is after the 
valuation date.  

US Qualified Pension Plans 
♦ Bipartisan Budget Act of 2015. ProVal now supports the extended interest rate stabilization 

and PBGC premium increases in accordance with the Bipartisan Budget Act of 2015. (This was 
actually included as an update to version 3.07, but mentioned here in case you missed it.) 

♦ More projected benefit payments are available in the output menu, including: PBGC NAR, 
PBGC NAR EIR, Max Tax PUC At-Risk AL, Max Tax PUC At-Risk NC, Funding At-Risk NC, Max 
Tax UC EIR, Max Tax UC Not-at-Risk AL, Max Tax UC Not-at-Risk NC, Max Tax UC At-Risk AL, 
and Max Tax UC At-Risk NC. 

♦ Effective interest rates for the Max Tax UC Not-at-risk and PBGC liabilities are now 
available. 

♦ Target liability mortality by coded field is available for actives. This lets you apply separate 
mortality, such as blue and white collar mortality, to different groups in the same run. 

♦ In Inactive Benefits, the option to exclude the benefit from PBGC liabilities has been extended 
to PPA vested liabilities. 

 
♦ In PPA funding Valuation Assumptions, the option to “Reflect new accrual rates during the 

valuation year in PUC and UC liabilities” no longer affects vested liabilities. In accordance with 
PBGC 2013 Blue Book Q1 response for flat dollar plans with negotiated increases, the vested 
liability now reflects the multiplier in effect on the valuation date. 

♦ In Valuation Assumptions, a new option lets you select the decrement timing for accelerated at-
risk 100% retirement rates. 

♦ In Asset & Funding Policies, the contribution schedule lets you specify which contributions to 
include in the expected return on assets calculation. This lets you base it on expected 
contributions when expense was calculated even if actual contributions differ. 
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OPEB Plans 
♦ GASB 74/75. OPEB mode now supports GASB 74/75. Accounting runs calculate the Entry Age 

Normal Liability and the Asset & Funding Policies include GASB 74/75 accounting parameters. 
For more, see GASB Statements No. 74 and 75 on page 11. 

Canadian Registered Pension Plans 
♦ Deferral of new amortizations New special payments can be deferred for 1 year. 

♦ Letter of credit parameters have been clarified and enhanced. In Asset & Funding Policies, 
the Letters of Credit parameters have been combined into a new topic. New enhancements 
allow you to increase the letter of credits each year to cover new special payments, apply a 
maximum limit to the letter of credit, an option to allow new special payments to be always 
covered by a letter of credit regardless of the maximum limitation, and options to include 
interest on the letter of credit. 

 
♦ Solvency liability calculations under Federal law have been enhanced to:   

o Let you calculate the Transfer Value based on the commuted value of the termination 
benefits (as opposed to eligible benefits which are typically retirement) when comparing the 
Annuity Purchase to the Transfer Value. 

 
o Allow you to use only the immediate annuity purchase assumptions for any participants that 

have reached the unreduced payment age. 
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German Pension Plans 
♦ Contractual allocation end dates can now be entered for cash balance and career average 

benefit formula components. In tax valuations, these components will be assumed to end as 
specified. In accounting valuations, you have the option to assume that contracts renew and 
allocations continue. 

♦ Simple interest increases and start age. Increase rate tables applied to accrual definitions 
can now apply simple interest starting at a specified age. 

♦ Projection to exact retirement age. When projecting accrual definitions to a future age, the 
projection will be to the exact retirement age in that year, rather than the nearest valuation 
date anniversary. 

♦ COLA timing for retirement benefits. COLAs on retirement benefits can now optionally occur 
on the anniversary of the retirement date. 

 

Mortality Tables 
♦ SOA mortality improvement scale MP-2015 has been added to ProVal’s Mortality 

Improvement Scales library. To use MP-2015 in one of the ways published by the SOA: 

o Create a new, blank Mortality Rates table 

o Check “Link mortality base rates” and draw rates from one of the eight “SOA RP-2014…” or 
eight “SOA RPH-2014…” tables.  

 
o Check “Apply Improvement Scale” and select SOA Scale MP-2015.  

o Specify the base year corresponding to the base rates you picked, either 2006 for the “… 
Adjusted to 2006 …” tables or 2014 otherwise. 

o Name the table and save it. 

Alternatively, you can import the desired table from the MP-2015 Mortality Tables Template 
available on our website. 

Note that the eight mortality tables entitled “RP[H]-2014 Adjusted to 2006 … (base rates 
only)”, which back out scale MP-2014 prior to 2014, should not be used directly. They are 
provided only as a source table from which the Link base rates feature can draw relevant 
mortality base rates. 

♦ Individual mortality tables. A new option lets you view a mortality table which has fully 
generational improvement scales applied for an individual of age x in year y. This combines the 

http://www.winklevoss.com/ProVal/Downloads.aspx#mp2015
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base mortality and improvement scale factors to form the individual table. This is useful in 
checking payment form values in sample lives, administration factors, etc. 

 
♦ When linking to mortality base rates, sex-distinct rates can now be transformed to unisex rates 

by blending male and female rates by a specified percentage. 

Administration Factors 
♦ Factors for an individual. You can now generate factors for an individual age x in the 

valuation year based on a mortality table with a fully generational  improvement scale applied 
or for a specific year of birth with an age by year of birth mortality table. Factors at younger or 
older ages relate to this same individual, e.g., if the participant is age 65 in 2015, then the age 
60 factor is for that individual in 2010 rather than someone age 60 in 2015. 

 

Individual Results 
♦ Individual results for components. In a valuation, you can now save individual results for 

benefit formula components. For example, you can save the current value of benefit formula 
components (e.g., your plan’s main formula, social security offset, etc.) for use in such things 
as benefit statements without having to set up dummy benefits to capture these amounts. 

♦ In individual results, if viewing results by benefit or component, you can select which benefits 
and/or components to display. 

♦ For “vested valued as active” participants, individual results are now available for the earliest 
retirement age, current benefit, and projected benefit.  
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Benefit Formulas 
♦ When double-clicking on an undefined benefit formula component, ProVal will default to a 

“database field” component rather than an “accrual definition” component if the name matches 
a data dictionary entry.  

 
 

 
♦ When projecting accrual definitions to a future age: 

o The projection age can be specified as a database field 

o The pay credits can be projected as a fraction of the projected accrual rates 

 
♦ The #AVGWB custom operator can be parameterized to end the averaging period up to 5 years 

prior to decrement. 

Experience Studies 
♦ Individual results are now available in experience studies. This is useful for checking results or 

summarizing results differently from ProVal’s standard reports.  

♦ A new option in Report Breakpoints lets you display salary output with full precision rather than 
rounding to no more than nine significant digits (e.g., “Salaries shown in 1,000s”). 

Census Data 
♦ In Spreadsheet Edit, the Sort Records interface has been simplified for clarity and ease of use. 

 
♦ In Spreadsheet Edit, the prompt to save the view style when exiting has been refined and won’t 

display if only insignificant changes were made.  
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♦ In Import Data, the question to “import data from another file?” has been eliminated since it’s 
so easy to run Import Data again, especially from within Spreadsheet Edit. 

♦ The output of custom screening tests that compare fields now shows the “% difference” for 
flagged records. 

 
♦ The “Import…” button for Databases now includes an option to “Import data into [the selected 

database]” as well as the pre-existing option to “Import database from another client”. 

 

Sample Lives 
♦ The Decrements sample life report now shows the service used for each decrement. 

Processing Speed 
♦ #IF #THEN #ELSE has been sped up dramatically when used in benefit formulas, accrual basis 

expressions, and COLA expressions. 

♦ When running lots of records (e.g., 100,000+) with a sizeable grid (e.g., 100 grid processors), 
the performance of aggregating results has been improved by using multiple threads to queue 
up intermediate results in memory for aggregation. 

System 
♦ When comparing entries, such as Valuation Assumptions, a new option only shows sections of 

the listing that differ. 

 
♦ Using File > Import from client is now much faster for clients with a large number of valuations 

and core projections. 

♦ In File > Open Client, you can now double-click on a client name to open it. Also, when 
Browsing for a folder, your Favorites are now listed for easy access. 

♦ A potential delay opening and closing clients when usage tracking is turned on ([Config] 
UsageLogFile= in proval.ini) has been eliminated by writing to this log asynchronously. 
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♦ The Graph command has been retired from the Tools menu.  

Report Writer 
♦ A new option lets you convert blank values to zeroes when publishing a report. 

 
♦ PPA shortfall amortization factors are now available for use in reports. 

♦ Arithmetic expressions (using ProVal’s arithmetic operators) can be written into a form field in 
the Template Document. These are intended to be used for simple expressions such as A+B 
and are subject to Microsoft Word’s limits of 138 characters. See the help article in Command 
Reference > Tools Menu > Report Writer > Templates: Form Field Reference for details. 

♦ ProVal API functions for report writing have been added. See the “ProVal API Users Guide.pdf” 
for details. 

o New functions GetRWReconOfAssets, GetRWStmntOfAssets, SetRWReconOfAssets, and 
SetRWStmntOfAssets return and set the “Reconciliation of Assets” and the “Statement of 
Assets” data for a report definition in a report writer database.  

o New function GetRWDataSets returns the data sets mapping for a report definition in a 
report writer database. 

ProVal PS 
♦ The charts in ProVal PS now have smoother lines, grid lines, graduated bar colors, and overall a 

more polished and modern look. This is in keeping with ProVal PS’s target as a boardroom level 
tool. 

♦ ProVal PS API 

o A new function, ImportCMS, imports capital market simulation trial data (economic 
scenarios) and creates a .cms file that can be linked to .pvps files using ResetCMS or 
LinkToCMS. 

o The daily roll forward calculations have been extended to solvency benefit payments in 
Canadian Registered Pension mode.  

Changes Log 
♦ Be sure to read the changes log (see the “changes log.doc” file in the ProVal directory) about 

updates to certain calculations that may change results. 

New member of the WinTech team 
We are pleased to introduce Sean Smith who 
recently joined our team. He is an experienced 
ProVal user and, among other responsibilities, 
will be working on ProVal enhancements. 
Please say hello to him if you reach him at 
ProVal support. 
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GASB Statements No. 74 and 75 
ProVal 3.08 supports GASB’s updated Postemployment Benefit Plans Other Than Pension Plans 
reporting standards, Nos. 74 and 75. This enhancement in ProVal’s OPEB computational mode 
parallels the public computational mode enhancement for GASB Statements No. 67 and 68 that 
was introduced in ProVal 3.05.  Below is a summary of the enhancements to ProVal as well as 
information to calculate the discount rate. 

Enhancements to Valuation Assumptions, Valuation Results, and Core Projection Results 
The Accounting Valuation Assumptions > Liability Methods topic has a new checkbox: “Calculate 
Entry Age Normal (APBO always run).” If checked, the Entry Age Normal liability will be calculated 
using the following parameters as prescribed by GASB: 

• Basis: Level % of salary  
• Funding span: From first funding age to last age before 100% retirement 
• Employee contribution methodology: Expected contributions for the year 

There are options on the screen for calculating present value of future salary and valuation salary, 
consistent with funding assumptions.  

   
The Entry Age Normal accounting liability and the average expected service lives are available from 
valuation and core projection output, and there are new scaling factors for the Entry Age Normal 
accounting liability and normal cost. 

Enhancements to Asset & Funding Policies, Valuation Sets, Deterministic & Stochastic 
Forecasts 
In the Asset & Funding Policy, the Accounting Methodology topic lets you select GASB 74/75 and 
specify the inputs necessary to develop the OPEB expense and Statement of Balance Sheet 
Liability.   



 
 

What’s New, ProVal version 3.08 - 12 - January 2016 

 
The schedule of deferred outflows & inflows should include the current year difference between 
expected and actual earnings (asset gain/loss). ProVal backs into the current year difference 
between expected and actual experience (liability gain/loss) using the funded status, the net OPEB 
liability, and the sum of outstanding deferred outflows and inflows (including current year asset 
gain/loss).  

New liability gains and losses and assumptions changes will be recognized over the average 
expected service lives. The numerator is the active total expected future service. The denominator 
is the active headcount expected to receive benefits plus the inactive headcount. If rounding is 
selected, this value will be rounded to 4 decimal places. Asset gains and losses calculated by ProVal 
will be recognized over five years and plan changes will be recognized in the year they occur. There 
is also an option to recognize new net deferred outflows using an increase rate. 

The Valuation Set, Deterministic & Stochastic View and Output include GASB 74/75 output 
variables of relevant parameters. There are three new Exhibits: 

• Development of OPEB Expense  
• Reconciliation of Balance Sheet Liability  
• Deferred Outflows & Inflows of Resources 

Additional Notes 
• The Entry Age Normal Accounting Liability has been added as a liability type option for the 

end of year additional contribution, the Ultimate Cost Liability, and the Target Cost 
calculations and as a liability target option in an excess return efficient frontier. 

• The Entry Age Normal Accounting liability can be selected as a liability type in a gain/loss 
analysis. 

Discount rate 
The discount rate should be the single rate that blends the long-term expected rate of return on 
investments and a 20-year tax-exempt general obligation municipal bond based on the years the 
plan’s net position is sufficient to pay projected benefits. If a blended interest rate is needed, 
ProVal will not determine the discount rate directly. However, you can derive the rate using ProVal 
output. Although GASB 74 and 75 do not provide details of this calculation, GASB 68 did provide 
details in Table 1 of Illustration 1. Two approaches, following the GASB 68 Illustration, are 
discussed in the ProVal Help’s Frequently Asked Question entitled GASB 68 discount rate. 

http://helpconsole/helpconsole6/ProVal%20308/default.aspx#pageid=gasb_68_discount_rate
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Dynamic Asset Allocation 
ProVal 3.08 introduces the ability to run several alternative types of “Dynamic Asset Allocation” 
during a stochastic forecast, allowing you to change between mixes during a forecast based on a 
set of rules or triggers.  

ProVal has always allowed you to set up and forecast multiple asset mixes within a single run 
where each mix is held constant (and is rebalanced) during the duration of the forecast. For 
example, here is a set of 3.07 parameters with 7 distinct asset mixes that will generate 7 
stochastic forecasts: 

  
ProVal 3.08 allows you to change between mixes during a forecast based on a set of rules or 
triggers. The triggers may be defined using funded ratios, interest rates and time. This strategy is 
sometimes referred to as a glide path strategy or dynamic de-risking. We have generalized it to 
“Dynamic Asset Allocation.” 

Here is an example using the same 7 mixes. Note that the mixes have been re-ordered, with 
ascending Mix #’s corresponding to ascending risk levels of the mixes. Re-ordering the mixes is 
cosmetic, but doing so produces a Mix Map that looks more intuitive and possibly easier to check. 
Note also that these parameters will generate a single stochastic forecast, as the 7 mixes are only 
definitional. 
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Thus, in this example, once the funded ratio surpasses 80%, the mix will change from Mix #7 
(60/40 mix, see its definition in the Asset Mixes table) to Mix #6 (50/50 mix). Also, if a trial was 
using Mix #6 and suddenly (perhaps due to the trial producing extremely favorable investment 
returns for a given year) its funded ratio shot up to 112%, it would immediately switch to Mix #1. 

ProVal’s Dynamic Asset Allocation feature allows you to customize: 

• The basis for the triggers:  funded ratio, funded ratio and interest rates, or calendar year. 

• Several items under the Params button: 

o Definition of the funded ratio: the desired liability and asset value 

o Funded ratio breakpoints 

o Interest rate breakpoints 

o Interest rate basis (Treasuries or Corporate) 

• Whether or not to allow re-risking.  If re-risking is not allowed, once the plan moves to a 
(presumably) less risky mix as the funded ratio rises, it never returns to a riskier mix, 
regardless of the plan’s funded status or the current level of interest rates.  If re-risking is 
allowed, the mix each year is determined based on that year’s funded ratio. 

• Whether to defer the start of the dynamic policy for a few years.  
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